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I.  INTRODUCTION 

 
This document describes the gas chromatographic (GC) operation and analyses of PCBs and pesticides in air and 
precipitation samples collected from six sites on the Great Lakes.  This research is conducted at the O’Neill School of 
Public and Environmental Affairs, Indiana University, Bloomington, as a part of the Integrated Atmospheric 
Deposition Network (IADN).  The Great Lakes National Program Office of the U.S Environmental Protection Office 
supports the research.   
 
There are two GC instruments used for analysis of PCBs and pesticides.  These are: 

 
1.    Hewlett Packard GC 6890 Series with an Electronic Pressure Control and Autosampler.  It is referred as GC 1.  
        Installed in by HP Engineer Thomas Kruzil on June 10, 1999 in SPEA 471 
       GC Model No. G1530A       
       GC Serial No. US00028275 
 
       Autosampler 7683 Series Injector 
       Tower Model No. G2613A 
       Tower Serial No.  US91907156 
       Tray Model No. G2614 A 
       Tray Serial No. US91605038 
       
       Micro ECD with Ni63, U33126 Date 03/18 
   
2.    Agilent GC 6890N with an Electronic Pressure Control and Autosampler.  It is referred as GC 2.   Installed             
by HP Engineer Mike Hartz on March 14, 2005 in SPEA 471  
       GC  Model No. G1530N       
       GC  Serial No. CN10505016 
 
        Autosampler 7683 B Series Injector 
        Tower Model No. 2913A 
         Tower Serial No. CN50423215 
        Tray Model No. G2614 A 
       Tray No. CN50331934 
          
        Micro ECD with Ni63, U36843 Date 04/20 
 
A 60m, DB-5 column and a 60m, DB-1701 column with 0.25mm id and 0.1μ film thickness are used for good 
resolution of PCBs and pesticides in 6890 GC1 and GC2. Hydrogen and Nitrogen, ultrapure grade, are used as carrier 
gas and detector make-up gas. Data acquisition is done with OpenLab CDS A.02.02, a GC Chemstation upgrade 
C.01.07.  Data quantitation is done with Mass Hunter version B.09.00 build 9.0.647.0.      
 
Hexane fraction of a sample after silica gel cleanup is used for the analysis of PCBs, HCB, p,p’-DDE, p,p’-DDT, 
trans-nonachlor, aldrin, o,p’-DDT, and octachlorostyrene in DB 5 column.  The 50% dichloromethane/hexane fraction 
is used for analyses of the other pesticides on both DB-5 and DB-1701.  After GC work, the mass of the analytes are 
calculated by internal standard (ISTD) quantitation procedure. The ISTDs for PCB analysis are PCB congeners 30 
and 204.  The ISTDs for the pesticides are PCB congeners 65 and 155. 
 
For every GC run one hexane blank and a calibration standard are run for checking the instrument background and for 
calibrating the instrument.  A common reference standard is also run to check the performance of the instrument.  
Another calibration standard is run at the end to check the shift of response factor of the instrument during the run.  
Another hexane blank is run at the end to check the cleanliness of the instrument after the samples are run.   
  
 
 

Arnold, Karen A
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Relative response factors (RRFs) for each analyte are determined from the calibration standard’s peak areas using 
equation, 
 

RRF  =  mass
area

mass
areastd

a std istd std

a istd






 ÷







    

 
Where massa is the analyte’s known mass in the injected amount of calibration standard, areaa is the analyte’s peak 
area, massistd is the known mass of the appropriate internal standard, and areaistd is that internal standard’s peak area. 
 
An analyte's mass in a sample (massa) is calculated from the RRFstd above and the internal standard response in the 
sample by the following equation: 
 

( ) ( )mass area RRF mass
areaa sample a sample std

istd

istd sample

= × ×






        

 
where areaa is the analyte’s peak area in the sample, massistd is the mass of internal standard spiked into the sample, 
and areaistd is the internal standard’s peak area in the sample.  
 
The routine GC maintenance, daily operation, instrument calibration, and the quantitation are described in the 
following sections. 
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II. ROUTINE GC MAINTENANCE 
 
1. Gas Tanks 
 

Check the gas tanks.  Tanks should not go dry.  While changing the tank, lower the temperature of the GC 
oven down to 400C.  Leave it at 400C for about 15 minutes after changing the tank to get rid of air or 
oxygen that was drawn in. 

 
2.           Head Pressure 
 

It is electronically controlled in 6890.  It should be at 22-24 psi.   
 
3. GC oven baking 
 

Before every GC1 run bake the oven at 2800C, the injector at 2800C, and the detector at 3800C for 1 hour. 
For GC2 bake the oven temperature to 2600C, the injector at 2800C, and the detector at 3800C for 1 hour. 

          
4. Septum 
 

a) After every 50- 60 samples or so change the septum.              
    b) Cool the oven down to 40 0C. 
             c) Remove autosampler tower. 
    d) Remove septum nut and take the old septum out.  Discard. 

e) Using clean Q-tips dipped in hexane, wipe off the septum holder.  
f) Put a new clean septum and replace the nut.  Nut should be snug but not too tight.   

 
5.   Background 
 

For 6890 the output is 190-300 mz. Hexane is analyzed at the start of every GC run to monitor the baseline 
stability.  If the signal goes up or hexane run produces noisy chromatogram GC should be cleaned. 

 
6. Standard 
 

A Common Calibration Standard for PCBs and a Mixed Pesticide Standard should be monitored to check 
the peak detection and the peak broadening or tailing.  If the peak shapes are not satisfactory, column 
should be clipped.   Altogether 97 peaks (including PCBs, pesticides, surrogate, and internal standards) 
should be detected in PCB standard.  There should be 56 resolved PCB peaks, 29 unresolved peaks, 3 
surrogate standards peaks, 2 internal standards peaks, and 7 pesticides.  Congener 17, 18, and 77 should be 
separated.  If not, install a new column.   In mixed pesticide standard there should be 22 pesticide peaks, 2 
internal standards peaks, and 3 surrogate standard peaks. 

 
7. Checking Leaks and Gas Flow in 6890 
 

Check leaks once in two weeks with a leak detector.  Check around the septum, at the injector end, and at 
the detector end of the column. 
 
Approximate gas flows are as follows: 
  Split vent   61.4 mL/min 
  Total flow   70 mL/min 
  Initial column flow  2 mL/min 
  Detector gas flow   40 mL/min 
The gas flows are set electronically.  Sometimes it is advisable to monitor the gas flow with a flow meter to 
check if the electronic set up match with the actual flow.  
The detailed GC 6890 conditions and method information for DB-5 and DB-1701 columns are printed out 
and added in the appendix. 
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III. GC CLEANING 
 

CLIPPING OLD COLUMN OR INSTALLING A NEW COLUMN 
 
1. Taking Apart 
 

a) Turn oven, injector, and detector off. 
 

b) Turn hydrogen and nitrogen off manually or electronically.  Wait until everything cools down. 
    

c) Take the autosampler tower off.   
                                                             
d) Undo the small nut covering the septum and the large nut underneath it to expose the injection 

liner.  Take the liner out. 
 

e) Open the oven.  Take the column out (by detaching from injector and detector ends). 
 

f) Unscrew the nuts from both injector and detector ends of columns and plug the column ends with 
a septum.  Open end of the column should not be exposed to air.  

 
g) Place the column on the workbench.                                

 
h) Unscrew the holder nut underneath the injection liner.  There is a dual vespel ring inlet gold seal in 

it.  The gold seal needs to be replaced each time they are taken apart.  Clean these parts by 
ultrasonication with dichloromethane and hexane and air dry.  Clean inlet as specified in step i) 
below.  These steps are done when there is a problem with signal or base line. 

 
i) Agilent’s preferred method of injection port cleaning is as follows:  

 
Materials: Q-tips, Hexane, Methanol, Acetone, and Methylene Chloride solvents in this order. 
Proceed with the following steps after completing steps a-h. 

 
1. Place a beaker under the inlet to catch any solvent that should drip from the inlet. 

 
2. Using multiple new Q-tips at once (picture shown below), dip the Q-tips in the hexane and 

then push Q-tip through the entire body of the inlet weldment.  Rotate the Q-tip so that all 
surfaces are cleaned. 
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3. Make sure the Q-tips push tightly against the walls of the weldment, like running a "gun 
brush" through a gun barrel. 
 

4. Run through at least 4 times then inspect the Q-tip. 
 

5. If Q-tip is heavily soiled, get new Q-tips and repeat until Q-tips show no dirt.    
 

6. Repeat steps 2-5 with methanol. 
 

7. Repeat steps 2-5 with acetone. 
 

8. Repeat steps 2-5 with methylene chloride. 
 

9. Install new liner and inert gold seal. 
 

10. Put inlet back together (as mentioned below in next step Assembling Injection Port and Liner) 
and run pressure decay test. 

 
11. If no leaks found, let hydrogen run through inlet for 30 minutes before heating. 

 
2. Assembling Injection Port and Liner 
 

a)  If steps h) and i) are performed, assemble the holder nut.  The tapered opening of the seal will 
face downward (the tapered end will hold the end of the ferrule from the column).  Screw the nut 
in before placing the injection liner. 

 
b) Insert a new liner. 

 
c) In 6890 GC1 put a viton O-ring (Agilent part # 5188-5385) on the liner. In 6890 GC2 put a flip 

top viton O-ring (Agilent part # 5188-5366).   Put the big nut on and tighten it.  Put in a clean 
septum.  Cover the septum with septum nut (Agilent part #18740-69835). Tighten with a wrench. 

 
 
3. Clipping Column  
 
 

a) Take the nut off the injector end of the column. Carefully scrape out all the ferrules from the 
column nuts, if the ferrule does not come out replace with a new column nut (Agilent part #5181-
8830) that has been cleaned. Clean all the different parts with a Q-tip dipped in dichloromethane 
(DCM) and ultrasonicate these parts with DCM and hexane for 10 minutes with each solvent.  
After column nuts are cleaned, insert the nut first and then a new ferrule with conical end pointing 
towards the open end of the column. 

 
b) Clip the column.  Make a clean cut with diamond tip score or ceramic square.  Examine the cut 

with a magnifying glass.  It should be a clean cut without any jagged edges.  Always clip the 
column after putting septum, nut, and the ferrule on. 

 
c) Place the septum so that 25 mm is measure from the tip of the column to the top of the septum.     

 
d) Carefully insert the column with nut and ferrule through the holder nut and screw it in.  Hand 

tighten the screw more and make it tight with wrench 1/4 turn after hand tight.  Do not over 
tighten. 

 
e) Take the nut off the detector end of the column. Remove old ferrule.  Turn hydrogen on and check 
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the flow of gas through the column by inserting the end in a beaker of hexane.  Turn hydrogen off. 
If this is a new column, allow gas to flow through column for 15 minutes to allow the column to 
bleed before inserting into the detector.  Put the septum, nut and the new ferrule on the column in 
the same way as in the injector end.  Clip the column and check for the nice clean cut.   

 
f) Place the septum so that 71 mm is measure from the tip of the column to the top of the septum. 

Tighten the screw.   
 

 
4 Checking Leaks and Gas Flow 
 
 

a) Turn H2 and N2 on.  Check leaks with a leak detector.  Check around the septum, at the injector, 
and at the detector ends of the column inside the oven.  Check that the head pressure for H2 is 22-
24 psi. 

 
b) Gas flow in 6890 should be back to electronic initial set up. 

  
       GC1  GC2 

  Split vent   61.4 mL/min 61.4 mL/min 
  Total flow   70 mL/min 70 mL/min 
  Initial column flow  2 mL/min 2 mL/min 

Detector gas flow   40 mL/min 30 mL/min  
 
 
5. Assembling 
 
 

a) Reinstall the autosampler tower. 
 

b) Turn the heated zones on. 
 

c) Turn oven on and set the temperature to 400C for an hour.  Change oven temperature to 700C and 
leave another hour. Change oven temperature to 1000C. 

 
d) If it is an old column, bake the column, injector, and detector for an hour.  

 
Baking temperature: 

 
Oven:  2800C (GC1), 2600C (GC2) 
Front Inlet: 2800C 
Front Detector: 3800C  

 
 e) If it is a new column, bake injector, and detector only.  Column should be conditioned by ramping 

it 1 degree per minute to 2800C (GC1) or 2600C (GC2).  Hold there for 1 hour. 
 

 f) If blank run looks satisfactory, check a standard. 
 

 
5 Changing micro ECD liner:  
   
 a) Turn off oven, injector, and detector temperatures. 
 

b) Turn H2 and N2 gases off manually or electronically. 
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c) Open oven door. Unscrew the column nut from the detector end of column. Plug column end. 
 

d) Unscrew the capillary column adapter and remove from the detector. Plug detector end. 
 

e) Remove cap from the capillary column adapter. Take out micro-ECD liner (Agilent Part #G2397-
20540). 

 
f) Check bottom of the adapter to see if the graphite ferrule from the column nut did not block the 

opening. 
 

g) Using care do not touch the micro-ECD liner with bare fingers.  Insert new micro-ECD liner and 
replace the cap. 

 
h) Remove plug and insert the capillary column adapter back into the detector end and tighten the 

nut. 
 

i) Remove the plug from the column and clip the detector end of the column as is mentioned on 
clipping the column. 
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IV.  ROUTINE GC OPERATION 
 
1. GC condition and oven temperature program: 
 

PCBs, hexachlorobenzene, p,p’-DDE, aldrin, o,p’-DDT, octachlorostyrene, about 50% of trans-nonachlor, 
and p,p’-DDT are eluted in the hexane fraction, whereas the other chlorinated pesticides and PAHs are 
eluted in the 50% dichloromethane in hexane fraction after the silica gel column chromatography.  The 
procedure for nitrogen blow down, spiking with internal standard, and making microvials for the 
autosampler are described in IADN Project Sample Preparation Procedure, Version 1.9, October 2020. 
 
GC 6890    GC-1   GC-2    
Carrier gas:    Hydrogen   Hydrogen    
Make up gas    Nitrogen   Nitrogen 
Split vent    61.4 mL/min  61.4 mL/min 
Total flow    70 mL/min  70 mL/min 
Initial column flow   2 mL/min  2 mL/min 
Detector gas flow    40 mL/min  30 mL/min 
 
The detailed GC conditions for the GCs are attached in appendix. 

   
2. Temperature Program for 6890  

 
GC1 6890, DB-5     GC2 6890, DB-1701 
Initial temp. 1000 C    Initial temp. 1000 C 
Initial time 1 min.    Initial time 1 min. 
Rate  10 C/min    Rate  100 C/min 
Final temp. 2400 C    Final temp. 1600 C 
Rate A  100 C/min   Rate A  0.6 C/min 
Final temp A  2800 C    Final temp A  2220 C 
Final time 20 min.    Rate B  100 C/min 
Purge time 0.5 min.    Final temp B  2600 C 
Run time 165 min    Final time 20 min. 
      Purge time 0.5 min 
      Run time 134.13 min. 

 
Mike Mullin specified the gas types, GC condition, column type, and the oven temperature program.  The 
method name is Mullin.m. The method was modified for GC2 and named 1701(3).m. 

 
3.            GC Pre-run 

 
a)   Check if there is sufficient H2 and N2 for operation.  If not, change the tank(s).  If necessary, change the 
septum. 
 
 b)  Bake oven at 280 0C (DB-5) or at 260 0C (DB-1701), injector and detector at 280 0C, and 380 0C 
respectively for about an hour.       
                                                                   

         c)   Cool oven to 100 0C, injector to 250 0C, and detector to 350 0C. 
      
Make the samples ready in microvials and load the autosampler tray.   

 
4. Logging into the computer 
  

a) Username Karen 
b) Password ******** 
c) Domain BL-SPEA-Lab GC (non-ADS)        
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5. Preparing Sequence in ChemStation 
 

Open OpenLab.  Open South GC or GCSPEA and then Instrument 1 or 2 (GC1 or GC2) 
 
 
 

 
 
a) Type in the subdirectory name (Batch ID).  Type the information about calibration standard, dates, and 
spikes in the comment section. 
 
b) Set the prefix/counter, signal 1: Type in analysis date as prefix. Example J2704 (data acquired on 
January 27, 2004). Counter should be 001.  
 
c) Prepare a sample table with hexane blank, calibration standard, calibration reference standard, and actual 
samples with proper ID's.  At the end of each sample ID indicate whether the sample is a hexane fraction or 
50% fraction with H or F1.  Repeat a fresh hexane blank and a fresh standard at the end of the sequence.   
 
 d) Save the sequence in c:\chem32\1\Data\ (created batch ID) \ batch ID.S file for GC1 (DB-5) and 
c:\chem32\2\Data\(created batch ID)\batch ID.S file for GC2 (DB-1701). 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Method and Run 
 

Sequence parameter Sequence 
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Chart 1 

 
A Typical Pesticide Sequence for a GC run 

 
 
 
Sequence Parameters: 
 
  Operator:                          
 
  Data File Naming:                Prefix/Counter 
  Signal 1  Prefix:                 s0809 
  Counter:                  001 
  Signal 2  Prefix:                 SIG2 
  Counter:                  0001 
  Data Directory:                   C:\HPCHEM\2\DATA\ 
 
  Data Subdirectory:               A09CF1 
 
  Part of Methods to run:          According to Runtime Checklist 
 
  Barcode Reader:                  not used 
 
  Shutdown Cmd/Macro:              none 
 
  Sequence Comment: 
  9/8/09 6890 gc1 db-5.pestcalst (b23) bottle 2 4/13/09. Pesticide Common 
reference Standard (pestcrs) (b5) 5/5/09   
     
 
Sequence Table (Front Injector): 
 
  Method and Injection Info Part: 
 
  Line Vial SampleName       Method   Inj SampleType InjVolume DataFile 
  ==== ==== ================ ======== === ========== ========= ========== 
 
    1  1    hexane blank     MULLIN   1   Sample         2.0                   
    2  2    pestcalst 090908 MULLIN   1   Sample         2.0                   
    3  3    pestcalst 090908 MULLIN   1   Sample         2.0                   
    4  4    pestcrs 090908   MULLIN   1   Sample         2.0                   
    5  5    lbc 090824,f1    MULLIN   1   Sample         2.0                   
    6  6    msc 090824,f1    MULLIN   1   Sample         2.0                   
    7  7    eh 01c 090408,f1 MULLIN   1   Sample         2.0                   
    8  8    sh 02c 090408,f1 MULLIN   1   Sample         2.0                   
    9  9    th 01c 090408,f1 MULLIN   1   Sample         2.0                   
   10  10   pestcalst 090908 MULLIN   1   Sample         2.0                   
   11  11   ch02c1 090408,f1 MULLIN   1   Sample         2.0                   
   12  12   ch02c2 090408,f1 MULLIN   1   Sample         2.0                   
   13  13   ph 01c 090408,f1 MULLIN   1   Sample         2.0                   
   14  14   lh 01c 090408,f1 MULLIN   1   Sample         2.0                   
   15  15   pestcalst 090908 MULLIN   1   Sample         2.0                   
   16  16   hexane blank     MULLIN   1   Sample         2.0                   
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Sequence Table (Back Injector): 
  No entries - empty table! 
 
 
6.  GC run 
 
a) Starting a 6890 GC run  
 
HPChemStation controls this instrument.  After saving the sequence start the instrument with the following steps in 
the computer. 
 
 
 
 
 
d) Post GC run 
 
The data files (*.d folders) will be saved on C:\chem32\1 or 2 data\.  Copy the data on flash drive and transfer to 
L:/HitesR/personnel/name of person analyzing data. This will be copied and worked on with the final file placed in the 
L;/HitesR/completed?name of person that did the analysis.  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Run Sequence OpenLab 
 

Method and run control Run 
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V. Mass Hunter Quantitation 

GENERAL INTEGRATION AND REPORTING 
 

 
1. Translate data. 

 
When using Open Lab for data acquisition, the data will need to be translated for Mass Hunter. If Mass 
Hunter is used to acquire data, the data should not need translation.  To translate data, use a GCMS 
translator software package in Mass Hunter.  
 
a) Open GC/MS Translator. 
 
b) Under MSD Chemstation click on Translate Data Files. 
 
c)  Browse to the folder containing the data files to import. 

 
d) Check the box for In-place translation. 

 
e) Browse to the output folder where translated files will go. 

 
f) Click Start Translation. Click close once completed. 
 

2. Create a new batch. 
 
a) Select File>New Batch, and navigate to, or create the directory where you want to store the batch and 

the results of your analysis (the batch directory). 
 

b) In the File Name field, type the name you wish to assign to the batch directory. 
 
c) Press Open. The Quantitative Analysis program will: 
 

1) Create a folder named QuantResults in the batch directory. 
 

2) Create a batch file with the name you specified and the extension.batch.bin. 
 

3) Save the filename.batch.bin file to the QuantResults directory. 
 

4) Put the batch filename in the title bar of the current batch. 
 
d) To add samples to this batch, select File>Add Samples. The Quantitative Analysis program will 

display a list of all the data files in the batch directory.  
 

e) Select the files you want to include in the batch.  
Press the Select All button to select all the data files in the directory, or select files using the shift and 
control keys to select groups and skip groups, then press OK. 
 

f) You are returned to the Batch Table window. Each sample selected for the batch is included as a 
single line in a batch. 

 
g) Select File>Save Batch to save work up to this point. 
 
h) The batch directory now contains all the data file folders selected, plus the folder created by 

Quantitative Analysis program named QuantResults, with the filename.batch.bin file. 
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i) Create New Method or load a current method for the batch. 
 
j) Analyze the data after method applied to batch by clicking Analyze. 
 

 
3. Creating a new method. 

 
From the main window, main menu, click Method>New>New Method from Acquired Scan Data. The 
New Method from Acquired Data dialog box opens. 

a)   Navigate to and select the folder that contains the scan data saved by your MassHunter Data 
Acquisition program. Agilent recommends that you select data with a high signal so that a representative 
chromatogram and spectrum can be easily viewed and click Open. 

b) Click OK. The Method Edit view opens, the deconvolution algorithm is applied, and the method is 
created from your data acquisition file. The method table is displayed. 

c) If the Method Setup Tasks menu is not open on the left side of the screen, go to the main menu, and 
select View>Method Development Tasks. 

d) Go to the Method Setup Tasks menu, select Compound Setup. Under name in the table select the 
retention time of each compound and rename to the compound of interest. Verify the compounds and their 
retention times. Compounds can be added or removed manually.  

e) From the Method Setup Tasks menu, select ISTD Setup. Locate the Internals and input their 
concentration and assign the ISTD to each target compound. 

g) From the Method Setup Tasks menu, select Concentration Setup. This creates the calibration levels 
and concentrations for each compound in the new method. 

h) From Method Setup Tasks menu, select Calibration Curve Setup. Change the calibration curve 
parameters. The Curve Fit (CF) should be linear, the CF origin should be included and the CF weight 
should have none. 

i) From the Method Setup Tasks menu, Select Globals Setup.  These boxes should be checked: Apply 
Multiplier to Matrix Spike, Apply Multiplier to Surrogate, and Apply Multiplier to Target.  The 
Correlation Window should be 1, the Non-Reference Window should be 0.25 with the Non Reference 
Window Type being in %, the Reference Window should be 0.25 and the Reference Window Type 
being in %, and verify these global parameters. 

j) From the Outlier Setup Tasks menu, limits can be set for various parameters. The Signal-to-Noise 
Ratio should be 3. Limit of Detection (LOD) will be determined one to two times per year after running 
an Instrument Detection Limits (IDL) study, these values will be adjusted accordingly. 

 
k) From the Advanced Tasks menu, the integration parameters can be set.  Mass Hunter sets the default to 
Agile2, which is a more robust integration, however, we are sticking with the type of integration we use 
with Open Lab.  Under the tab INT., select the box and chose Universal under integration and then select 
Apply to All. Next select the Parameters box and input under the Universal tab the inital parameters:  
 
Threshold  10 
Peak Width  0.04 
Area Reject 5 
 
 
 
 
 



IADN GC Procedure 
Version 2.0 

December 2023 

14 
 

  
Next by selecting Peak Filter you can change the following: 
 
Peak Area Counts   
Peak Height   
Peak Area (%)   
Peak Height (%)   
Signal to Noise   
Limit to the largest  
 
Only one of these filters can be applied at a time. Open lab had Peak Area % at 5, however, the Signal to 
Noise ratio will eliminate small peaks that may show as a peak but is background noise. However, if there 
is a specific peak that is a problem you can apply any on these filters to that specific peak in the method.  
For example, there is a peak near 135+144 that can be problematic to calculations for 135+144 in smaller 
concentrations.  A signal to noise filter can be applied to that congener and if the peak is below the signal to 
noise it would not allow for quantitation.  

l) From Advanced Tasks menu, a smoothing parameter can be set.  Check calibration peaks to check if 
some peaks need smoothing, these are usually the smaller peaks. Go to Smoothing tab and select Gaussian. 
Smoothing Function Width can be increased, as this is increased the Smoothing Gaussian Width must 
also increase and maintain difference of 10 between the two. For example, Cong.11 needs smoothing and 
the Smoothing Function width is increase from 15 to 20, therefore, the smoothing Gaussian Width must 
increase and will increase from 5 to 10 to keep the difference of 10.  This may not be necessary to include 
in the parameters but can be used to help with peaks that are small and may not appear smooth in the 
chromatograph.     

m) From the Method Tasks menu find Validate and validate the method.  Correct any errors. Errors will 
show up by double clicking on the listed error and will go straight to the error in the method. Once all errors 
are fixed, validate again until no errors found.  Once completed Save Method and Exit. 
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Chart 2 

 
A Typical Batch Sequence for PCB Data Set in Mass Hunter 

 

 
 
 

Chart 3 
 

A Typical Batch Sequence for a Pesticide Data Set in Mass Hunter 
 

 
 

 
 
 

! Flag Name Data File Type Vial Level
Sample 
Group AcqDate_Time Acq Operator RT

Final 
Conc Area

hexane blank d3119001.d Blank 1 1 mm/dd/yyyy
ccs(b10) 191231 d3119002.d Cal 2 1 1 mm/dd/yyyy
pcb crs 191231 d3119003.d QC 3 1 mm/dd/yyyy
msc 191224,h d3119004.d Sample 4 1 mm/dd/yyyy

eh 01c 191101,h d3119005.d Sample 5 1 mm/dd/yyyy
sh 01c 191101,h d3119006.d Sample 6 1 mm/dd/yyyy
th 01c 191101,h d3119007.d Sample 7 1 mm/dd/yyyy
ch 02c 191101,h d3119008.d Sample 8 1 mm/dd/yyyy
lh 01c 191101,h d3119009.d Sample 9 1 mm/dd/yyyy
pp 01c 191101,h d3119010.d Sample 10 1 mm/dd/yyyy

ccs(b10) 1912131 d3119011.d Cal 11 1 mm/dd/yyyy
hexane blank d3119012.d Blank 12 1 mm/dd/yyyy

Compound nameSample

! Flag Name Data File Type Vial Level
Sample 
Group AcqDate_Time Acq Operator RT

Final 
Conc Area

hexane blank d3119001.d Blank 1 1 mm/dd/yyyy
pestcalst 191231 d3119002.d Sample 2 1 mm/dd/yyyy
pestcalst 191231 d3119003.d Cal 3 1 1 mm/dd/yyyy
pcb crs 191231 d3119004.d QC 4 1 mm/dd/yyyy
msc 191224,h d3119005.d Sample 5 1 mm/dd/yyyy

eh 01c 191101,h d3119006.d Sample 6 1 mm/dd/yyyy
sh 01c 191101,h d3119007.d Sample 7 1 mm/dd/yyyy
pestcalst 191231 d3119008.d Cal 8 1 2 mm/dd/yyyy
th 01c 191101,h d3119009.d Sample 9 2 mm/dd/yyyy
ch 02c 191101,h d3119010.d Sample 10 2 mm/dd/yyyy
lh 01c 191101,h d3119011.d Sample 11 2 mm/dd/yyyy
pp 01c 191101,h d3119012.d Sample 12 2 mm/dd/yyyy
pestcalst 191231 d3119013.d Sample 13 2 mm/dd/yyyy

hexane blank d3119014.d Blank 14 2 mm/dd/yyyy

Sample Compound name
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4. Loading an existing method 
 
Click on Method tab then click on Open tab, a drop-down menu will show. Click on Open from existing 
file. Browse to the proper folder that have the methods setup for each instrument and each fraction, i.e., 
ccs.m, pest.m, or 1701.m.  The method will open, changes can be made for concentration, retention times, 
internal standard, and compound names which can be updated, as necessary. When these adjustments have 
been made, save method as the method in the set being quantitated. Exit the method. 
 
 

5. Integration of a chromatogram 
 

Parameters for Mass Hunter default to Agile2 which is a more robust quantitation. In order to stay as close 
as data quantitation of past software, we have put in place the following parameters: 

 
a) Starting Parameters should be found in Edit Method/Integration Parameters Setup. Click box next to 
compound name under INT., a drop-down menu will open. Click and find Universal. Set this to Apply 
to all. Click on the box below named parameters. These are the following initial parameters: 
 

 Threshold  10  
 Peak Width    0.04     

Area Reject    5    
 
Once these are verified, click on Peak Filter tab. Verify the peak threshold and maximum number of  
peaks. 
 
Peak Area Counts  10000 
Peak Height  10000 
Peak Area (%)  5 
Peak Height (%)  5 
Signal to Noise  3 
Limit to the largest 100  
 
Only one of these filters can be utilized in the method. See comments on creating new method.  Save 
method to set the parameters if changes are needed. Exit edit method. 

 
 b) Manually integrate using 1 of 2 pathways after updating the retention time in the method. 
   

1) Compounds-at-a-Glance. This method allows you to see several of the compounds at one time. 
 
Click View tab then Click Compounds-at-a-Glance. This opens to show several samples in a grid 
format in one location. Click on one of the squares so it is highlighted around the square and right click 
for menu and click on properties.  Several items can be custom made to help identify peaks easier. Find 
Peak annotations this will allow showing of retention times, area, final concentration, etc., if so desired 
for your viewing. Next go to Reference RT and click on the box on the right. A menu will pop up. 
Check box for Show reference RT. Adjust the settings to your preference for the color and type of line 
used for showing the RT for all the compounds. Click okay, Click apply. Close properties and setting 
should now be visible in all the grids.  
 
Each square will show the specified compound within the time set up with the retention time in the 
method. If the setting has right and left delta at 3 minutes, then the time frame will show 3 minutes prior 
to the retention time of the compound and 3 minutes after the retention time of the compound. 
 
Manual integration is already operational, a baseline can be set by clicking on the icons for snapping 
and baseline and dropping a baseline. Once this has been done the peak will turn a different color to 
show a manual integration. Do this for each compound.  
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Chart 4 

 
A Typical Chart for Manual Integration Using Compounds-at-a-Glance in Mass Hunter 

 

 
 
 

2) Compound Information.  This allows for looking at a single compound in a single chromatograph. Using 
arrow will determine whether you look at the compound to the right of the current compound or looking at 
the same compound of the next chromatograph. Click on the icon for manual integration and the use then 
Click on snapping and dropping baseline. Do this for each compound. 
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Chart 5 
 

A Typical Chart for Manual Integration Using Compound Information in Mass Hunter 
 

 
 

 
 
c) Save batch and export table with quantitated results. 
 

1) Click on File then Save Batch.  
2) Click on File, Export and then Export Table. Place created table into the data set by 

browsing to the correct set. The program will want to automatically place in the last set where 
a table was exported. The export table can now be used with a macro to upload data to the 
reporting data sheets. 
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VI. PESTICIDE Reference Table, 50% FRACTION 
 
 

Inject a Mixed Pesticide Standard and load the standard chromatogram in Mass Hunter.  Correct baseline, 
integrate, and identify the pesticide peaks (except HCB, p,p'-DDE, aldrin, o,p’-DDT, and 
octachlorostyrene) from the following Reference Table.  This Reference Table was prepared from 
individual pesticide injection.   

 
    

Chart 6 
 

Pesticide Reference Table, DB5 Column 
 

Compounds  GC Retention time   concentration 
         Min. (approx.)               ng/ml 
 

α-HCH    36   20 
Hexachlorobenzene  37   20 

   β-HCH     41   20 
γ-HCH    42   20 
δ-HCH     47   20 
e-HCH    48   20 
Aldrin    60   20 
Congener 65 (ISTD)  61   20 
Heptachloroepoxide  67.8   20 
Oxychlordane   68.1   20 
γ-Chlordane    72   20  
Congener 155(RF)  73   20 
Endosulfan I   74   20  
α-Chlordane   75   20  
t-Nonachlor   76   20  
Dieldrin    79   20 
p,p'-DDE   81   20 
o,p’-DDD   81.8   20 
Endrin    82   20 
Endosulfan II   84   20  
p,p'-DDD   88   20 
o,p’-DDT   88.2   20 
Endosulfan sulfate  92   20  
p,p'-DDT   94   20 
Methoxychlor    106   20 
Dibutylchlorendate  112   20 
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Chart 7 
 

Pesticide Reference Table, 1701 Column 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Compound Name GC Retention Time 
Min (approx.) 

Concentration 
(ng/ml) 

Hexachlorobenzene 16 20 
α-HCH 19 20 
γ-HCH 23 20 
Aldrin 28 2.5 
Congener 65 (ISTD)  29 20 
β-HCH 35 20 
e-HCH 36 20 
Oxychlordane 37 20 
Congener 155 (Ref) 37.5 20 
δ-HCH 38 20 
Heptachlorepoxide 39 20 
Endosulfan I 43 20 
γ-Chlordane 46 20 
α-Chlordane 47 20 
T-Nonachlor 48 20 
p,p’-DDE 50 20 
Dieldrin 51 20 
Endrin 54 20 
o,p’-DDD 57 20 
o,p’-DDT 59 2.5 
Endosulfan II 66 20 
p,p’-DDD 68 20 
p,p’-DDT 71 20 
Endosulfan sulfate 85 20 
Methoxychlor 89 20 
Dibutylchlorendate 92 20 
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Chromatogram 1 

 
Pesticides Calibration Standard Chromatogram, DB5 
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Chart 8 

Pesticide Calibration Table, DB5 
Method Information 

 

 
 
 
 
 
 
 
 
 
 
 

 

Compound Method pestcalst 200810 ISTD Method
Name RT Final Conc. Area Name ISTD Conc.
A-HCH 36.133 20 58767399 Cong. 65 20

HCB 36.964 20 134615331 Cong. 65 20
B-HCH 41.094 20 24758765 Cong. 65 20
G-HCH 41.738 20 44015825 Cong. 65 20
D-HCH 46.483 20 52368583 Cong. 65 20
Epsilon 47.872 20 34229273 Cong. 65 20
Aldrin 60.014 20 53914061 Cong. 65 20

Cong. 65 60.576 20 87539709
Heptachlor Epoxide 67.726 20 43598268 Cong. 65 20

Oxychordane 67.958 20 36975797 Cong. 65 20
G-Chlordane 72.033 20 44933745 Cong. 65 20

Cong. 155 73.118 20 60255120 Cong. 65 20
Endosulfan I 73.781 20 38367732 Cong. 65 20
A-Chlordane 74.911 20 48353040 Cong. 65 20

T-Nona 75.946 20 42362541 Cong. 65 20
Dieldrin 78.551 20 42532986 Cong. 65 20
P,P' -DDE 80.638 20 71610715 Cong. 65 20
O,P' -DDD 81.694 20 24669098 Cong. 65 20

Endrin 81.969 20 26757287 Cong. 65 20
Endosulfan II 83.879 20 33076872 Cong. 65 20

P,P' -DDD 87.881 20 30852154 Cong. 65 20
O,P' DDT 88.067 20 18555786 Cong. 65 20

Endosulfan Sulfate 91.841 20 32535396 Cong. 65 20
P,P' -DDT 94.402 20 20368687 Cong. 65 20

Methoxychlor 105.841 20 9314981 Cong. 65 20
DBC 111.916 20 25229865 Cong. 65 20
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Chromatogram 2 
Pesticide Calibration Standard, 1701 Column 
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Chart 9 
Pesticide Calibration Table, 1701 

 

 

Compound Method pestcalst 200810 ISTD Method ISTD Results
Name RT Final Conc. Area Name ISTD Conc. RT Area
HCB 36.964 20 134615331 Cong. 65 20 60.576 87539709

A-HCH 36.133 20 58767399 Cong. 65 20 60.576 87539709
G-HCH 41.738 20 44015825 Cong. 65 20 60.576 87539709
Aldrin 60.014 20 53914061 Cong. 65 20 60.576 87539709

Cong. 65 60.576 20 87539709
B-HCH 41.094 20 24758765 Cong. 65 20 60.576 87539709
Epsilon 47.872 20 34229273 Cong. 65 20 60.576 87539709

Oxychordane 67.958 20 36975797 Cong. 65 20 60.576 87539709
Cong. 155 73.118 20 60255120 Cong. 65 20 60.576 87539709

D-HCH 46.483 20 52368583 Cong. 65 20 60.576 87539709
Heptachlor Epoxide 67.726 20 43598268 Cong. 65 20 60.576 87539709

Endosulfan I 73.781 20 38367732 Cong. 65 20 60.576 87539709
G-Chlordane 72.033 20 44933745 Cong. 65 20 60.576 87539709
A-Chlordane 74.911 20 48353040 Cong. 65 20 60.576 87539709

T-Nona 75.946 20 42362541 Cong. 65 20 60.576 87539709
P,P' -DDE 80.638 20 71610715 Cong. 65 20 60.576 87539709
Dieldrin 78.551 20 42532986 Cong. 65 20 60.576 87539709
Endrin 81.969 20 26757287 Cong. 65 20 60.576 87539709

O,P' -DDD 81.694 20 24669098 Cong. 65 20 60.576 87539709
O,P' DDT 88.067 20 18555786 Cong. 65 20 60.576 87539709

Endosulfan II 83.879 20 33076872 Cong. 65 20 60.576 87539709
P,P' -DDD 87.881 20 30852154 Cong. 65 20 60.576 87539709
P,P' -DDT 94.402 20 20368687 Cong. 65 20 60.576 87539709

Endosulfan Sulfate 91.841 20 32535396 Cong. 65 20 60.576 87539709
Methoxychlor 105.841 20 9314981 Cong. 65 20 60.576 87539709

DBC 111.916 20 25229865 Cong. 65 20 60.576 87539709
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Chromatogram 3 

Pesticide Sample Chromatogram 
Vapor Phase, DB-5  
EH 01C 190802, F1 
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Chart 10 
 

Pesticide Report, DB5 
 

 
 
 
 

A report will be exported from Mass Hunter and a macro will automatically place the final concentration data into 
the reporting spreadsheets.  To export table, make sure cursor is on the table and go to File>Export>Export Table. 
A box will pop up to allow the table to be placed in a specific file. 

 
 

Compound RT Area Final Conc.
A-HCH 36.099 32003216 10.471

HCB 37.014 0
B-HCH 41.11 0
G-HCH 41.745 0
D-HCH 46.514 56077349 20.589
Epsilon 47.895 37224796 20.910
Aldrin 60.004 0

Heptachlor Epoxide 67.73 7217142 3.183
Oxychlordane 67.955 0
G-Chlordane 72.072 7509744 3.214

Cong. 155 73.134 64664201 20.634
Endosulfan l 73.792 7130374 3.573
A-Chlordane 74.868 1630201 0.648

T-Nona 75.966 0
Dieldrin 78.555 22105244 9.993
P,P'-DDE 80.654 0
P,P'-DDD 81.752 1698480 1.324

Endrin 81.97 0
Endosulgan ll 83.896 0

P,P'-DDD 87.9 0
O,P'-DDT 88.101 0

Endosulfan Sulfate 91.862 0
P,P'-DDT 94.418 0

Methoxychlor 105.91 0
DBC 111.92 30692045 23.390
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Chromatogram 4 

 
Pesticide Sample Chromatogram 

Vapor Phase, 1701  
 

CH 02C1 190826,F1 
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VII.  PCB AND PESTICIDE DATA REDUCTION IN HEXANE FRACTION 
 
 
1. Creating a Method File  
 

a) Integration and Peak Identification 
 
Inject Common Calibration Standard which was mixed with (PCB 11, HCB, p,p'-DDE, t-nona, p,p'- DDT 
and Aldrin, o,p’-DDT, and octachlorostyrene). 
Load the standard chromatogram and integrate it following the direction in Chapter V.  
Identify PCBs from S-8074-AR1, S-8074-BR1, S-8074-CR1 (Chromatogram 6) and pesticides from 
individual pesticide standards in Pesticide Reference Table.  

    
2. Statistical Calculations 
 

The text files are imported to excel temporarily for statistical calculations.  A summary sheet with Total 
PCBs, percent recoveries of different surrogate standards is generated and printed out.  

       
A Chromatogram from Mike Mullin, PCB Standard Chromatogram, PCB Calibration Table, PCB 
Sample Chromatogram, PCB Internal Standard Report, and a PCB Integration Events are added in 
the following pages. 
 
A standard chromatogram of PCB Common Calibration Standard, custom made by AccuStandard, 
is also added (Chromatogram 7).  This standard has replaced the Mike Mullin’s 94 standard.  This 
standard is used by all IADN participating laboratories. 
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Chromatogram 5 
 

Mike Mullin’s 94 Standard with pesticides 
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Chromatogram 6 

 
PCB Common Calibration Standard Chromatogram 

(Custom made by AccuStandard, 2009) 
Lot# B5020104, B5020105, B5020115 
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Chart 11 
PCB Calibration Table (Common Calibration Standard) 

 
 

 

Compound Method ccs(b10) 200810 ISTD Method ISTD Results
Name RT Final Conc. Area Name ISTD Conc. RT Area
4+10 29.749 20 25422632 30 8 41.577 20942964
7+9 33.92 20 36503648 30 8 41.577 20942964

6 35.7 10 13614230 30 8 41.577 20942964
5+8 36.676 20 38796027 30 8 41.577 20942964
HCB 36.968 20 79478054 30 8 41.577 20942964

14 39.067 10 6968882 30 8 41.577 20942964
19 39.969 5 14561904 30 8 41.577 20942964
30 41.577 8 20942964
11 42.446 10 2567952 30 8 41.577 20942964
12 43.253 10 10498128 30 8 41.577 20942964
13 43.455 10 3232276 30 8 41.577 20942964
18 44.211 5 15510936 30 8 41.577 20942964

17+15 44.465 15 22389201 30 8 41.577 20942964
16 47.33 5 19547493 30 8 41.577 20942964
32 47.501 5 15263803 30 8 41.577 20942964
26 50.982 5 10408501 30 8 41.577 20942964
31 52.41 5 12106487 30 8 41.577 20942964
28 52.507 5 9817167 30 8 41.577 20942964
33 54.16 5 18772644 30 8 41.577 20942964
53 54.448 5 13784250 30 8 41.577 20942964
22 55.467 5 12851611 30 8 41.577 20942964
45 56.328 5 15617325 30 8 41.577 20942964
52 59.142 5 10811630 30 8 41.577 20942964
49 59.81 5 15085289 30 8 41.577 20942964

Aldrin 60.021 5 9477576 30 8 41.577 20942964
47 60.197 5 12897700 30 8 41.577 20942964
48 60.319 5 16486618 30 8 41.577 20942964

Cong. 65 60.587 10 23217956 30 8 41.577 20942964
44 62.585 5 15382577 30 8 41.577 20942964
37 62.919 5 5139142 30 8 41.577 20942964
42 63.087 5 14554268 30 8 41.577 20942964

41+71 64.543 10 35294852 30 8 41.577 20942964
64 64.715 5 14590603 30 8 41.577 20942964

100 67.416 5 11835174 30 8 41.577 20942964
Octachlorostyrene 67.942 5 14302737 30 8 41.577 20942964

74 69.049 5 9719061 30 8 41.577 20942964
70+76 69.853 10 21055922 30 8 41.577 20942964

66 70.343 5 9919027 30 8 41.577 20942964
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Compound Method ccs(b10) 200810 ISTD Method ISTD Results
Name RT Final Conc. Area Name ISTD Conc. RT Area

95 70.562 5 15327327 30 8 41.577 20942964
91 71.613 5 13343461 30 8 41.577 20942964

56+60 73.173 10 26500718 30 8 41.577 20942964
84+92 74.052 10 26360747 30 8 41.577 20942964

89 74.485 5 15012494 30 8 41.577 20942964
101 74.993 5 11400264 30 8 41.577 20942964
99 75.813 5 12025791 30 8 41.577 20942964

T-Nona 75.956 5 7999780 30 8 41.577 20942964
119 76.907 5 13259268 30 8 41.577 20942964
83 77.634 5 11778198 30 8 41.577 20942964
97 78.543 5 15758744 30 8 41.577 20942964
81 79.198 5 7253981 30 8 41.577 20942964
87 79.475 5 15089741 30 8 41.577 20942964
85 80.099 5 14498172 30 8 41.577 20942964

P,P'DDE 80.648 5 21908962 30 8 41.577 20942964
77 80.956 10 6081020 30 8 41.577 20942964

110 81.219 5 15717235 30 8 41.577 20942964
135+144 84.362 10 30461663 204 6 105.057 16412957
123+149 85.704 10 22513669 204 6 105.057 16412957

118 85.972 5 10960628 204 6 105.057 16412957
114 87.656 5 13436505 204 6 105.057 16412957
131 87.971 5 14066255 204 6 105.057 16412957

O,P',-DDT 88.072 5 1445538 204 6 105.057 16412957
105+132+153 90.298 15 35925733 204 6 105.057 16412957

P,P' DDT 94.42 5 2311967 204 6 105.057 16412957
163+138 94.79 10 29607760 204 6 105.057 16412957

126 96.173 5 8906855 204 6 105.057 16412957
166 96.981 5 14305121 204 6 105.057 16412957
128 99.28 5 15886098 204 6 105.057 16412957
167 99.982 5 10410008 204 6 105.057 16412957
174 101.857 5 15826841 204 6 105.057 16412957

202+171 103.439 10 23890591 204 6 105.057 16412957
156 103.647 5 13775058 204 6 105.057 16412957
204 105.057 6 16412957
172 105.815 5 15061093 204 6 105.057 16412957
180 106.882 5 13681157 204 6 105.057 16412957
199 108.547 5 15169013 204 6 105.057 16412957
169 110.182 5 8551005 204 6 105.057 16412957

170+190 111.657 10 35220273 204 6 105.057 16412957
201 113.337 5 18071046 204 6 105.057 16412957
207 120.236 5 14386315 204 6 105.057 16412957
194 122.677 5 15798693 204 6 105.057 16412957
205 123.441 5 12824541 204 6 105.057 16412957
206 128.778 5 14470461 204 6 105.057 16412957
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Chromatogram 7 
 

PCBs in Vapor Sample 
EH 01C 190802, H 
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ECD1 - A:Electron Capture Detector Signal #1 Translated from ChemStation ECD1A.CH Signal File AU10200000005.D (eh 01c 190802,h)
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Chart 12 
 

PCB Report 
 
 

 

Compound Method
Name RT Final Conc. Area Name ISTD Conc. RT Area
4+10 29.793 2.579 3203931 30 8 41.577 20942964
7+9 34.008 0.585 1042716 30 8 41.577 20942964

6 35.738 0 30 8 41.577 20942964
5+8 36.695 1.646 3121566 30 8 41.577 20942964
HCB 37.009 64.684 251235495 30 8 41.577 20942964
14 39.097 17.013 11588357 30 8 41.577 20942964
19 40.018 0 30 8 41.577 20942964
30 41.577 8.000 20942964
11 42.479 7.897 1982021 30 8 41.577 20942964
12 43.348 0 30 8 41.577 20942964
13 43.495 0 30 8 41.577 20942964
18 44.257 1.892 5736031 30 8 41.577 20942964

17+15 44.503 2.206 3217552 30 8 41.577 20942964
16 47.368 0.891 3406088 30 8 41.577 20942964
32 47.540 0.751 2240492 30 8 41.577 20942964
26 51.035 0.756 1538701 30 8 41.577 20942964
31 52.507 2.330 5514923 30 8 41.577 20942964
28 52.545 3.550 6811957 30 8 41.577 20942964
33 54.211 1.124 4126056 30 8 41.577 20942964
53 54.521 0.403 1086069 30 8 41.577 20942964
22 55.521 1.460 3668582 30 8 41.577 20942964
45 56.377 0.421 1286586 30 8 41.577 20942964
52 59.186 4.144 8758711 30 8 41.577 20942964
49 59.860 1.655 4879384 30 8 41.577 20942964

Aldrin 60.105 0 30 8 41.577 20942964
47 60.247 0.618 1556970 30 8 41.577 20942964
48 60.372 0.941 3032163 30 8 41.577 20942964

Cong. 65 60.633 4.072 9239902 30 8 41.577 20942964
44 62.634 2.257 6788051 30 8 41.577 20942964
37 62.961 2.097 2106354 30 8 41.577 20942964
42 63.119 0.909 2585356 30 8 41.577 20942964

41+71 64.583 1.090 3758747 30 8 41.577 20942964
64 64.753 1.362 3884668 30 8 41.577 20942964
100 67.467 0 30 8 41.577 20942964

Octachlorostyrene 67.980 0.418 1169401 30 8 41.577 20942964
74 69.088 1.479 2810370 30 8 41.577 20942964

70+76 69.882 3.288 6766157 30 8 41.577 20942964
66 70.377 2.325 4508738 30 8 41.577 20942964

EH 01C 190802,H ISTD Method ISTD Results
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Compound Method
95 70.601 2.884 8640454 30 8 41.577 20942964
91 71.646 0.813 2119930 30 8 41.577 20942964

56+60 73.213 2.072 5367953 30 8 41.577 20942964
84+92 74.086 2.271 5850224 30 8 41.577 20942964

89 74.582 0.296 868150 30 8 41.577 20942964
101 75.022 3.750 8357220 30 8 41.577 20942964
99 75.839 1.496 3516911 30 8 41.577 20942964

T-Nona 75.982 1.187 1856500 30 8 41.577 20942964
119 76.905 0.248 643489 30 8 41.577 20942964
83 77.662 0.173 398608 30 8 41.577 20942964
97 78.568 0.930 2865694 30 8 41.577 20942964
81 79.218 0.757 1073240 30 8 41.577 20942964
87 79.493 1.831 5400542 30 8 41.577 20942964
85 80.122 0.587 1664368 30 8 41.577 20942964

P,P'DDE 80.670 0.720 3082912 30 8 41.577 20942964
77 80.994 0.477 283726 30 8 41.577 20942964
110 81.246 2.772 8515596 30 8 41.577 20942964

135+144 84.359 1.137 4545336 204 6 105.057 16412957
123+149 85.725 1.157 3419852 204 6 105.057 16412957

118 85.992 1.251 3598430 204 6 105.057 16412957
114 87.658 0.108 382105 204 6 105.057 16412957
131 87.969 0 204 6 105.057 16412957

O,P',-DDT 88.081 0 204 6 105.057 16412957
105+132+153 90.296 1.898 5967475 204 6 105.057 16412957

P,P' DDT 94.429 1.446 877598 204 6 105.057 16412957
163+138 94.851 1.414 5492791 204 6 105.057 16412957

126 96.181 0 204 6 105.057 16412957
166 96.987 3.971 14910853 204 6 105.057 16412957
128 99.287 0 204 6 105.057 16412957
167 99.946 0 204 6 105.057 16412957
174 101.888 0.103 427339 204 6 105.057 16412957

202+171 103.432 0.057 178994 204 6 105.057 16412957
156 103.625 0 204 6 105.057 16412957
204 105.057 6.000 16412957
172 105.798 0 204 6 105.057 16412957
180 106.894 0.143 513722 204 6 105.057 16412957
199 108.533 0 204 6 105.057 16412957
169 110.148 0 204 6 105.057 16412957

170+190 111.610 0.037 172712 204 6 105.057 16412957
201 113.351 0.040 187978 204 6 105.057 16412957
207 120.206 0 204 6 105.057 16412957
194 122.649 0.172 712008 204 6 105.057 16412957
205 123.448 0 204 6 105.057 16412957
206 128.789 0 204 6 105.057 16412957

EH 01C 190802,H ISTD Method ISTD Results
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VIII.  Appendix: Method Information from GC 6890 
 

======================================================================= 
 
                                6890 GC1 METHOD 
======================================================================= 
 
 
OVEN for GC1 
   Initial temp:  100 'C (On)              Maximum temp:  350 'C 
   Initial time:  1.00 min                 Equilibration time:  1.00 min 
   Ramps: 
      #  Rate  Final temp  Final time 
      1  1.00      240        0.00 
      2 10.00      280        20.00 
      3 0.0(Off) 
   Post temp:  100 'C 
   Post time:  0.00 min 
   Run time:   165.00 min 
 
 
FRONT INLET (UNKNOWN)                   BACK INLET () 
   Mode:  Splitless 
   Initial temp:  250 'C (On) 
   Pressure:   22.00 psi (On) 
   Purge flow:   61.4 mL/min 
   Purge time:   0.50 min 
   Total flow:   69.1 mL/min 
   Gas saver:   On 
   Saver flow:   20.0 mL/min 
   Saver time:   3.00 min 
   Gas type:   Hydrogen 
 
COLUMN 1                                COLUMN 2 
   Capillary Column                     (not installed) 
   Model Number:   J&W  
   Max temperature:   350 'C 
   Nominal length:   60.0 m 
   Nominal diameter:  250.00 um 
   Nominal film thickness:  0.10 um 
   Mode:  constant pressure 
   Pressure:  22.00 psi 
   Nominal initial flow:  1.0 mL/min 
   Average velocity:     35 cm/sec 
   Inlet:  Front Inlet 
   Outlet:  Front Detector 
   Outlet pressure:  ambient 
 
FRONT DETECTOR (µECD)                   BACK DETECTOR (NO DET) 
   Temperature:  350 'C (On) 
   Mode:  Constant makeup flow 
   Makeup flow:  40.0 mL/min (On) 
   Makeup Gas Type: Nitrogen 
   Electrometer:  On 
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SIGNAL 1                                SIGNAL 2 
   Data rate:  20 Hz                       Data rate:  20 Hz 
   Type:  front detector                   Type:  front detector 
   Save Data:  On                          Save Data:  Off 
   Zero:  0.0 (Off)                        Zero:  0.0 (Off) 
   Range:  0                               Range:  0 
   Fast Peaks:  Off                        Fast Peaks:  Off 
   Attenuation:  0                         Attenuation:  0 
 
COLUMN COMP 1                           COLUMN COMP 2 
Derive from front detector              Derive from front detector 
 
                                        POST RUN 
                                        Post Time: 0.00 min 
TIME TABLE 
   Time       Specifier                 Parameter & Setpoint 
 
 
                                GC Injector 
 
 
     Front Injector: 
        Sample Washes                 1 
        Sample Pumps                  3 
        Injection Volume            2.0 microliters 
        Syringe Size               10.0 microliters 
        PostInj Solvent A Washes      3 
        PostInj Solvent B Washes      3 
        Viscosity Delay               0 seconds 
        Plunger Speed              Fast 
        PreInjection Dwell         0.00 minutes 
        PostInjection Dwell        0.00 minutes 
 
     Back Injector: 
No parameters specified 
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============================================================================= 
                                6890 GC2 METHOD 
============================================================================= 
 
OVEN 
   Initial temp:  100 'C (On)              Maximum temp:  325 'C 
   Initial time:  1.00 min                 Equilibration time:  1.00 min 
   Ramps: 
      #  Rate  Final temp  Final time 
      1 10.00      160        0.00 
      2  0.60      222        0.00 
      3 10.00      260       20.00 
      4   0.0(Off) 
   Post temp:  100 'C 
   Post time:  0.00 min 
   Run time:  134.13 min 
 
FRONT INLET (UNKNOWN)                   BACK INLET () 
   Mode:  Splitless 
   Initial temp:  250 'C (On) 
   Pressure:  22.00 psi (On) 
   Purge flow:  61.4 mL/min 
   Purge time:  0.50 min 
   Total flow:  70.7 mL/min 
   Gas saver:  On 
   Saver flow:  20.0 mL/min 
   Saver time:  3.00 min 
   Gas type:  Hydrogen 
 
COLUMN 1                                COLUMN 2 
   Capillary Column                        (not installed) 
   Model Number:  Restek rtx-1701 
   Max temperature:  260 'C 
   Nominal length:  60.0 m 
   Nominal diameter:  250.00 um 
   Nominal film thickness:  0.10 um 
   Mode:  constant pressure 
   Pressure:  22.00 psi 
   Nominal initial flow:  2.0 mL/min 
   Average velocity:  45 cm/sec 
   Inlet:  Front Inlet 
   Outlet:  Front Detector 
   Outlet pressure:  ambient 
 
FRONT DETECTOR (µECD)                   BACK DETECTOR (NO DET) 
   Temperature:  350 'C (On) 
   Mode:  Constant makeup flow 
   Makeup flow:  30.0 mL/min (On) 
   Makeup Gas Type: Nitrogen 
   Electrometer:  On 
 
SIGNAL 1                                SIGNAL 2 
   Data rate:  20 Hz                       Data rate:  20 Hz 
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   Type:  front detector                   Type:  front detector 
   Save Data:  On                          Save Data:  Off 
   Zero:  0.0 (Off)                        Zero:  0.0 (Off) 
   Range:  0                               Range:  0 
   Fast Peaks:  Off                        Fast Peaks:  Off 
   Attenuation:  0                         Attenuation:  0 
 
COLUMN COMP 1                           COLUMN COMP 2 
   Derive from front detector              Derive from front detector 
 
 
                                        POST RUN 
                                           Post Time: 0.00 min 
 
TIME TABLE 
   Time       Specifier                     Parameter & Setpoint 
 
 
                                GC Injector 
 
 
     Front Injector: 
        Sample Washes                 1 
        Sample Pumps                  3 
        Injection Volume            1.0 microliters 
        Syringe Size               10.0 microliters 
        PostInj Solvent A Washes      3 
        PostInj Solvent B Washes      3 
        Viscosity Delay               0 seconds 
        Plunger Speed              Fast 
        PreInjection Dwell         0.00 minutes 
        PostInjection Dwell        0.00 minutes 
 
     Back Injector: 
No parameters specified 
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